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Introduction

Paragon Partition Manager™ 12 Free is designed to do drive partitioning on computers that host Windows and Mac OS
X environments. The program supports the latest Windows 8 and enables to enables to resize partitions of Apple Boot
Camp.

In this manual you will find the answers to many of the technical questions, which might arise while using the program.

Our company is constantly releasing new versions and updates to its software, that's why
images shown in this manual may be different from what you see on your screen.

What's New in Partition Manager 12
e Support of Windows 8.

e Support of the restart-free installation.

Features Overview

This chapter dwells upon key benefits and technical highlights of the product.

Features

Let us list some of the features:

User Friendly Fault Minimizing Interface
e Graphical representation of the data to gain a better understanding.

e A handy Launcher to easily find and run the required tasks.

e Comprehensive wizards to simplify even the most complex operations.
e A context sensitive hint system for all functions of the program.

e Previewing the resulting layout of hard disks before actually executing operations (so-called virtual

operations).

Partition/Hard Disk Management Facilities

e Basic functions for initializing, partitioning and formatting hard disks (create, format, delete). Instead of the

standard Windows disk tools, the program supports all popular file systems.

o Express Create Partition Wizard to create a new partition in the most appropriate place of a hard disk, format it

to NTFS and then make it available in the system by assigning a drive letter.

e Express Resize Partitions Wizard to increase free space on one partition by up-taking the unused space of an

adjacent partition of a hard disk (including partitions of Apple Boot Camp).

e NTFS hot resize upward to enlarge an NTFS partition (system, locked) without rebooting Windows and
interrupting its work.

e Convert a file system (FAT16/32, NTFS) without reformatting.

e Mount a partition (assign a drive letter) of any file system type to make it available for your operating system.
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5

e Modify file system parameters (make active/inactive, hide/unhide, etc.).

Supported Technologies

Along with using innovative technologies from outside, Paragon has developed a number of its own original
technologies that make its products unique and attractive for customers:

e Paragon Power Shield™ technology to provide data consistency in case of a hardware malfunction, power
outages or an operating system failure.

e Paragon UFSD™ technology to browse partitions of any file system including hidden and unmounted, modify
and copy files and folders, etc.

e Paragon Hot Resize™ technology to enlarge NTFS partitions (system, locked) without rebooting Windows and
interrupting its work.

e Paragon Smart Partition™ technology to securely perform hard disk partitioning operations of any complexity.

e Paragon BTE™ technology to set tasks for execution during the system restart, thus saving from the need to use
a bootable media when modifying system partitions.

e Microsoft Volume Shadow Copy Service (VSS) to provide the copy/backup infrastructure for the Microsoft
Windows XP/Vista/7/Server 2003/2008 operating systems. It offers a reliable mechanism to create consistent
point-in-time copies of data known as shadow copies. Developed by Microsoft in close cooperation with the
leading copy/backup solution vendors on the market, it is based on a snapshot technology concept.

Supported File Systems
e Full read/write access to FAT16/FAT32 partitions.

e Full read/write access to NTFS (Basic Disks). Compressed NTFS files are also supported.

e Limited read/write access to Apple HFS+ partitions.

Unfortunately, support of non-Roman characters for the HFS+ file system is unavailable at
the moment. The company is about to implement it in the nearest future.

Supported Media
e Support of both MBR and GPT hard disks (2.2TB+ disks included)
e |DE, SCSI and SATA hard disks
e SSD (Solid State Drive)
e AFD (Advanced Format Drive)
e Non-512B sector size drives
e CD-R, CD-RW, DVD-R, DVD+R, DVD-RW, DVD+RW, DVD-R, DVD+R double layer and also Blu-ray discs
e FireWire (i.e. IEEE1394), USB 1.0, USB 2.0, USB 3.0 hard disks

e PC card storage devices (MBR and GPT flash memory, etc.)
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Getting Started

In this chapter you will find all the information necessary to get the product ready to use.

System Requirements
For the Windows installation package
e Operating systems:

- Windows XP (32 and 64 bit)

- Windows Vista (32 and 64 bit)
- Windows 7 (32 and 64 bit)

- Windows 8 (32 and 64 bit)

e Internet Explorer 5.0 or higher

e Intel Pentium CPU or its equivalent, with 300 MHz processor clock speed
e 128 MB of RAM (256+ recommended)

e Hard disk drive with 250 MB of available space

e SVGA video adapter and monitor

e Keyboard

e Mouse

o During the installation additional free space (up to 1GB) will be required.

Installation
To install Paragon Partition Manager 12, please do the following:

1. Run Setup Application. Click on the *.MSiI file. This application will guide you through the process of the
program installation. The setup utility is compiled with the InstallShield SDK, hence it contains the standard user
interface and set of installation steps.

In case there is some previous version of the program installed on the computer, the
program will offer the user to uninstall it first.

2. Starting Setup. The Welcome page informs that the application is being installed. Click the Next button to
continue.

3. Confirm License Agreement. The License Agreement page displays the Paragon License Agreement. Read the
agreement and then select the appropriate option to accept. If you do not agree with any conditions stated
there, the installation process will be interrupted. By clicking the Print button, the License Agreement may also
be printed out.

Copyright© 1994-2013 Paragon Software GmbH. All rights reserved.



7

4. Provide Registration Information. On the Registration page you are to provide your product key and serial
number.

5. Provide Customer Information. On the Customer Information page you are to provide the standard
information, i.e. a user name and an organization. Besides you need to decide whether to make the program
available for all users of this computer (if several) or only for the current one.

6. Select an Installation Folder. The Destination Folder page allows you to choose a folder where the program will
be installed. By default, the installation folder will be created as:

C:\Program Files\Paragon\Paragon Partition Manager 12. To select another folder, click the Change... button.

After you have selected the required folder, click the Next button to continue.

Do not install the program on network drives. Do not use Terminal Server sessions to install
and run the program. In both cases, the program functionality will be limited.

7. Confirm Installation. On the Ready to Install the Program page click the Install button to start the installation or
the Back button to return to any of the previous pages and modify the installation settings.

8. Copying Files. The Copying Files page shows the overall progress of the installation. Click the Cancel button to
abort the setup.

9. Finishing the Installation. The Final page reports the end of the setup process. Click the Finish button to
complete the wizard.

First Start

To start Paragon Partition Manager 12 under Windows, please click the Windows Start button and then select Programs
> Paragon Partition Manager™ 12 > Paragon Partition Manager™.

The program provides wide opportunities in the field of hard disk structure modification, so
(D just to be on the safe side, please make a backup of your data before carrying out any

operation.

The first component that will be displayed is called the Express Launcher. Thanks to a well thought-out categorization
and hint system, it provides quick and easy access to wizards and utilities that we consider worth using on a regular
basis. With its help you can also start up the traditional launcher, the help system or go to the program’s home page.
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To know more on how to handle the product’s interface and accomplish typical operations,
please consult the Windows Components chapter.

Basic Concepts

This chapter explains terms and ideas that show how the program works. To understand these helps to obtain a general
notion of the operation performance and makes it easier for the user to operate the program.

Apple Boot Camp

Boot Camp is a special utility to help you set up a dual boot system (Mac OS X and 32-bit Windows XP/Vista) on Intel-
based Macs. It enables to securely re-partition your hard disk (resize an existing HFS+ partition to create a separate
partition for Windows) and then launch the installation process. With Boot Camp all the necessary drivers will be at your
disposal. Moreover after Windows has been installed it will serve as a boot manager to choose what operating system
to start up.

It is strongly recommended not to modify the hard disk configuration with Windows Disk
Manager. Otherwise it may lead to unexpected consequences, right up to BSOD and
inability to boot in Windows XP/Vista. Please use our program to correctly update both
MBR and GPT.
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64-bit Support

The bulk of software today is written for a 32-bit processor. It can meet the requirements of almost any end user.
However that is not the case when dealing with servers processing large amounts of data with complex calculations of
very large numbers. That is where 64-bit architecture comes into play.

It can boast improved scalability for business applications that enables to support more customer databases and more
simultaneous users on each server. Besides a 64-bit kernel can access more system resources, such as memory
allocation per user. A 64-bit processor can handle over 4 billion times more memory addresses than a 32-bit processor.
With these resources, even a very large database can be cached in memory.

Although many business applications run without problems on 32-bit systems, others have grown so complex that they
use up the 4 GB memory limitation of a 32-bit address space. With this large amount of data, fewer memory resources
are available to meet memory needs. On a 64-bit server, most queries are able to perform in the buffers available to the
database.

Some 32-bit applications make the transition to the 64-bit environment seamlessly others do not. For instance, system-
level utilities and programs that provide direct hardware access are likely to fail. Our program offers a full-fledged
support of the 64-bit architecture providing fault-tolerant work for such system dependent modules as Hot Processing.

Drive Partitioning

As you probably know a hard drive is to be split into one or more partitions, since it cannot hold data until it is carved up
and space is set aside for an operating system. Until recently most PCs used to have just one partition, which filled the
entire hard disk and contained an OS. The situation has changed however, thanks to new cost-effective high capacity
hard drives, thus opening up numerous possibilities for PC users, such as editing video, archiving music, backing up CD
images, etc. Huge increase in space is great, but it poses a number of problems, most important of which are effective
data organization and speed.

Large drives are always going to take longer to search than smaller volumes, and an operating system is going to have its
work cut out both finding and organizing files. It is for this reason that many people decide to invest in multiple hard
drives, but there is an easy solution — drive partitioning. Partitioning lets you divide a single physical drive into a number
of logical drives, each of which servers as a container with its own drive letter and volume label, thus enabling the
operating system to process data more efficiently. Besides partitioning makes it possible to organize data so that it is
easy to find and manage. You can set aside, for instance, 40 GB of a 160 GB hard drive for the OS, 70 GB for storing
video and another 50 GB for your favorite music collections to provide transparent data storage.

It is also worth mentioning to that with a hard drive properly partitioned, such routine operations as files de-
fragmentation or consistency check will not be that annoying and time-consuming any more.

By detaching the OS from the rest of the data you can tackle one more crucial issue — in case of a system malfunction,
you can get the system back on track in minutes by recovering it from a backup image located on the other partition of
the hard drive.

But that is not all drive partitioning may be used for. If you are willing to play games in Windows while browsing the
Internet in Linux, 100-percent sure that no virus will attack your PC, drive partitioning is a necessity. In order to run
several OSs on a single hard drive you are to create a corresponding number of partitions to effectively delineate the
boundaries of each OS.

Windows Components

In the given section you can find all the information necessary to successfully work with the Windows version of the
product.
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Interface Overview

This chapter introduces the graphical interface of the program. The design of the interface precludes any mistake being
made on the part of the user. Most operations are performed through the system of wizards. Buttons and menus are
accompanied by easy understandable icons. Nevertheless, any problems that might occur while managing the program

can be tackled by reading this very chapter.

General Layout

When you start the program, the first component that is displayed is called the Launcher. It enables to run wizards and

10

dialogs, to specify program settings, to visualize the operating environment and the hard disk configuration.

The Launcher’s window can be conditionally subdivided into several sections that differ in their purpose and

functionality:

Tools Changes Wizards Hard Disk P

IRODE & o

Virtual
Operations Bar

i"“

o= e |

isk 0 (VMware, VMware Virtual S SCSI ~ *

Common Tasks

m

Type: Hedeard
Volume Size: 16GB ExvlorerBar
Sedonpuuu:k 63

(5] Basic MBR Hard Disk 0
& Local Disk ©)

6% Sustem (F)

[5] Basic MBR Hard Disk 1 (VMware,

Size (sectors)

FS Size (sectors) ~ |
Partition List isk Dev) L3
4E6CE0h 1FFEFFR
al S SCSI Disk Dev)
ANFAREH AFIFFFR T

(1) No changes.

1. Main Menu
2. Tool Bar

3. Virtual Operations Bar

4, Common Tasks Bar

5. Explorer Bar
6. Disk Map
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7. Partition List

9. Legend Bar
9. Status Bar

A number of panels offer similar functionality with a synchronized layout. The program enables to conceal some of them
to simplify the interface management.

All panels are separated by vertical and horizontal expandable sliders, allowing the user to customize the screen layout.

Main Menu

The Main Menu provides access to the entire functionality of the program. The available functions are as listed below:

MENU ITEM FUNCTIONALITY

Tools

View Log Files View logs on the carried out operations

Log Saver A wizard will help you collect and send logs to the Paragon Support Team

Settings... Edit the general settings of the program

Exit Exit the program

Changes

Undo “the last virtual Cancel the last virtual operation on the List of Pending Operations

operation’

Redo “the last virtual Cancel the last undo virtual operation on the List of Pending Operations

operation’

View Changes... Display the List of Pending Operations

Apply Changes Launch the real execution of virtual operations

Discard All Changes Cancel all virtual operations on the List of Pending Operations

Reload Disk Info Refresh the current information about disks

Wizards

Express Create Partition... Create an NTFS partition and make it ready for work

Format Partition... Format a partition of any file system

Delete Partition... Delete a partition of any file system

Express Resize Partitions... Increase free space on one partition by up-taking the unused space of an
adjacent partition

Hard Disk

Update MBR Update MBR (Master Boot Record) of the selected hard disk
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Properties...

Get in-depth information on the properties of selected hard disk

Partition

Create Partition...

Create a partition

Format Partition...

Format a partition

Delete Partition...

Delete a partition

Move /Resize...

Move/Resize the selected partition

Convert File System...

Convert file system of the selected partition

Assign Drive Letter...

Assign drive letter to the selected partition

Remove Drive Letter...

Remove drive letter for the selected partition

Hide Partition...

Make the selected partition unavailable for the operating system

Unhide Partition...

Make the selected partition available for the operating system

Mark Partition as Active

Make the selected partition bootable by default

Mark Partition as Inactive

Make the selected partition non-bootable by default

Change Volume Label...

Change volume label of the selected partition

Test Surface...

Test surface of the selected partition/block of free space

Check File System
Integrity...

Check the selected partition for possible file system errors

Properties...

Get in-depth information on the properties of selected partition

View

Layouts Manage the Launcher layout with several predefined profiles

Toolbar Manage the Tool Bar representation: show / hide standard and navigation
buttons, text labels and large icons

Status Bar Display the Status Bar

Common Tasks Bar

Display the Common Tasks Bar

Disk Map Legend

Display the Disk Map legend

Properties and Commands

Display the Explorer Bar

Disk Map Location Select whether the Disk Map will be located on the top of the main window or
at the bottom

Help

Help Open the Help system (you can also do it by pressing F1)
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About Open the dialog with information about the program

o The Main Menu contents available at the moment may vary depending on the selected
object.

Tool Bar

The Toolbar provides fast access to the most frequently used operations:

BUTTON FUNCTIONALITY

,_'f:“"_'._-'“u Increase free space on one partition
S by up-taking the unused space of an
adjacent partition

Collect and send logs to Support

Switch to Express launcher

Open the Help system

S @

Virtual Operations Bar

The program supports previewing the resulting layout of hard disks before actually executing operations (so-called
virtual mode of execution). In fact, when the virtual mode is enabled, the program does not accomplish operations
immediately, but places them on the List of Pending Operations for later execution.

The Virtual Operations Bar enables to manage pending operations.

BUTTON FUNCTIONALITY

[é_ij Cancel the last virtual operation on the List of Pending Operations
(l;“\ Cancel the last undo virtual operation on the List of Pending
Operations

() Display the List of Pending Operations

Launch the real execution of virtual operations

% Cancel all virtual operations on the List of Pending Operations

Virtual mode is an effective way of protection from any troubles, since no operations will
be executed until clicking the Apply button for confirmation, thus giving a second chance to
weigh all pros and cons of this or that particular operation. The program politely reminds
the user that there are unsaved changes by showing the following window:
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I There are unsaved changes.

Please use the Apply command to comre the changeas and the )‘( Discard
command 1o permanently undo the changes

You can view the changes history via the . View Changes command and
temporarily undo of redo the oparation by means of the " Undo and " Redo

commands

Common Tasks Bar

The Common Tasks Bar is located on the left side of the main window. It is intended for easy access to the program's

wizards.

The bar contains several tabs. Each tab includes a separate button bar which can be folded by clicking it.

Basic Partitioning Tasks

E:F?P Express Create

Starting the Express Create Partition Wizard to create an NTFS partition and make
it ready for work.

@g Format Partition

Starting the Format Partition Wizard to format an existing partition to one of the
file systems supported by the program.

.
% Delete Partition

Starting the Delete Partition Wizard to delete a partition of any file system.

Advanced Partitioning Tasks

el
k= Express Resize

Starting the Express Resize Partitions Wizard to redistribute free space between
two adjacent partitions.

Tools

7 Log Saver

Starting the Log Saver Wizard to collect and send logs to Support.

Help and Documentation

-
Y\ g Partition Manager™ Help

Launching the help system (you can also do it by pressing F1).

\_.;ﬁ About Partition Manager™

Opening the page which contains information about the program. This page will
be displayed in the Explorer Bar.

Disk Map

The Disk Map is displayed in the Explorer Bar when the Disk View tab is selected. It is located either at the top or at the
bottom of the window, depending on the state of the Disk Map Location option (Main Menu: View > Disk Map

Location).

As the name infers, the Disk Map displays the layout of physical and logical disks. Physical disks are represented with
rectangle bars that contain small-sized bars. These small-sized bars represent logical disks. Their color depends on the
file system of the appropriate partition.
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Basic Hard Disk 0 (VMware, VMware Virtual S SCSI Disk Dev)

Local Disk (C:)
4395 GB NTFS

Large-sized bars display the following information about physical disks:
e Manufacturer,
e Model.

Small-sized bars display the following information about logical disks:
e Serial number,
e Drive letter,
e Totalsize,

o File system.

Furthermore, it is possible to estimate the used disk space by looking at the size of the bar’s shaded area. The program
offers to choose from several types of the disk layout scaling. It's done especially to increase the program usability. For
instance, if you’ve got a high capacity hard drive containing both very large (more than 100 GB) and rather small (less
than 10 GB) partitions, you can select the logarithmic type to make all partitions readable, otherwise (selecting the
linear type) you won’t be able to see small partitions at all, but thing strips. On the other hand, if the proportional disk
layout is critical for you, the linear type is exactly what you need.

Nevertheless there’s a compromise solution — linear scaling with the minimal limit to small partitions. So if a partition is
too small it will remain readable.

Just click on the arrow icon on the top right side of the Disk Map to select the desired scaling type.

v Linear
Linear Scaling Min Width
Loganthmic Scaling
]

=

Lirnex Ext4 ReizerFS

Disk Map is synchronized with the Explorer Bar. Thus by selecting a disk on the Disk Map, the Explorer Bar will
automatically display detailed information on it.

The drag-and-drop functionality is not available when the logarithmic type of the disk
layout is selected.

Explorer Bar

The Explorer Bar is located in the center of the main window which emphasizes its importance. The bar displays
reference information including:

e The help system
e General information on the product including its name, version and a list of helpful links
e Detailed information about disks selected on the Disk Map

According to these categories the Explorer Bar has several tabs:
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o Disk View, which offers the user the following options:
- Partition List to get a clear-cut picture of the current state of the system hard disks/partitions

- Properties to view detailed information on the selected partition/hard disk in the bright graphical form

o You can switch between these components by clicking tabs on the left side of the Explorer
Bar.

e Help, which contains the program help and general information on the product.
You can access the desired information by clicking on the appropriate tab.

The Explorer Bar is a fully-functional embedded HTML browser, which offers the possibility to address, for example, the
company's website to look through important technical notes or download the latest updates without having to close
the program.

The program help is also HTML-oriented. You can read it and follow external links from to get additional information.

To easily navigate through browsed pages, the program provides the following functionality:

BUTTON FUNCTIONALITY

"i";‘!} Return to the previously browsed
page

e Open the next browsed page

© p pag

Stop loading the current page

b

Refresh the contents of the current
page

Partition List

The Partition List is another helpful tool that enables you to get a clear-cut picture of the current state of the system
hard disks/partitions. Partitions are sorted according to their starting position. For every item of the list there is the
possibility to call the context-sensitive popup menu with available operations. Besides, the program provides detailed
information on all hard disks/partitions found in the system including the following properties:

- Name,

- Volume label (if exists),

- Partition type (Primary/Extended /Logical),
- File system type,

- Size,

- Amount of used and unused (free) space,

- Start/End cylinder,

- Start/End head,

- Start/End sector
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- Free size in sectors/bytes
- Active/Inactive attribute
- Hidden/Unhidden attribute

You may customize outlook of the Partition List by clicking on the arrow icon on the top right side of the panel.

Pleaze select properties to display.

Flease select properties you would lice to display in the Disks and Partitions view
MHams
Size isectors)
F5 Size (sactions) Mowe down
Usad (sactors)
Start (seciors)
End {sectors)
Stad CHS )
End CHS5 )
] File system

| Wiokuene label

| Partiion siza
] Size

| Usad

| Free fsectons)

Fres

] Actve
] Hiddan

| Letier

| Pasgion 1D

o] [ o] [ ][] ] [

| Saciors per Cluster
] Slet

By marking a checkbox opposite the required item you can choose whether to display it or not. Besides, you can change
its order by pressing the Move up or Move down buttons.

If you don’t need the Disk Map, please click the shown below icon to disable it:

Siadt fsectors) | End [secions) | Stad CHShent) | Bnd CHShex)

02021 504D 61 14
804D €115 FEFE 34 1E

%0 3ETFEFFM 02021 FEFE 4 IE

Legend Bar

The Legend Bar explains the color scheme used for disk and partition presentation. You can hide (or show) the bar with
the appropriate Main Menu item: View > Disk Map Legend. When it is activated it can be found at the bottom of the

Explorer Bar.

The program distinguishes between the following types of known file systems:
- FAT16/32
- NTFS
- Linux Ext2/3/4
- Apple HFS
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Status Bar
This is the bottom part of the main window. The Status Bar displays menu hints, for each item the cursor points to.

The user can hide (or show) the bar with the appropriate Main Menu item: View > Status Bar.

Settings Overview

The Settings dialog is available from the Main Menu: Tools > Settings. All the settings are grouped into several sections,
which functions are described in the following paragraphs. The list of sections is placed on the left side of the dialog. By
selecting a section from the list, you can open a set of options.

To get a detailed description to any setting, control, or field of the program just click the

o

hint button and then the object you need.

General Options

Ng General options

Partition Abgrment Mode

Wista El
Align partitions according to the nies usad in Windows Vista and later 05es.

Check: F5 integrity policy

Oz 3

Standand protection from data loss with acceptable paformance. The file system
inbegrity will be checked for each volume only once just before accomplshing
data-senstive operations

Deta Loss Protecton mods

Reset B

Mediam protection from data loss

This section contains a set of general options that will be taken into account during any operation carried out with the
program:

e Partition Alignment mode. There are three options you can choose from:

- Legacy. DOS and Windows OSes before Vista required that partitions had to be aligned to the “disk cylinder”
or 63 sectors to address and access sectors correctly. It was OK, until 4K hard drives came into scene. When
partitions are aligned this way on this type of disk, each logical cluster is linked to two physical 4K clusters,
thus resulting in a double read-write operation.

- Vista. Since Windows Vista, operating systems do not use the archaic CHS (cylinder/head/sector) addressing
scheme, but the Logical Block Addressing (LBA), where sectors are addressed continuously over the whole
disk drive. It is optimal for both, 512B and new 4K disk drivers.

- Inheritance. Select the option to disable automatic alignment of partitions.

e Check FS integrity policy. Accomplishment of any data-sensitive operation (resize, move, merge, redistribute,
change cluster size, etc.) is potential with data loss. To minimize this risk, it's recommended to check integrity of
your file system before this type of operations, despite the fact that it’s quite time consuming. We offer you
several options to let you choose, which is best for you:
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- Always. Maximum protection, but minimal performance. The file system integrity will be checked each time
it’s necessary to guarantee the maximum protection for the on-disk data.

- Once. Standard protection with acceptable performance. The file system integrity will be checked for each
volume only once just before accomplishing data-sensitive operations.

- Never. No protection, but maximum performance. If you're not 100% sure your disk is rock solid, please do
not use this option.

Data Loss Protection mode. To guarantee safety for your information when a data-sensitive operation has been
abruptly interrupted as a result of a computer reset, or a power outage, there are several techniques, that
correspond to the options below:

- Do not protect. No protection, but maximum performance. If you're not 100% sure you’re completely safe
from a power outage, or an accidental reset of your computer, please do not use this option.

- Reset. Standard protection with acceptable performance. Maintaining a special journal, our program
enables to automatically complete a data-sensitive operation interrupted by an accidental reset of your
computer from our bootable recovery media, thus reviving the corrupted partition.

- Power loss. Maximum protection, but minimal performance. Besides journaling, our program will also
disable cache of your disk when accomplishing data-sensitive operations to avoid data loss even in case of a
power outage.

General Copy and Backup Options

Hdd raw processing
Copy an entire hard disk sector by sector without taking into sccount 15 partiion stnucture

Partition ram processing
Copy/Backup each parttion sector by sactor, Al seciors wil be processad one by one (even unusad
sectors), Requires more time to complete the operation

| Skip O5 audbary files
Choose this option 1o skip 05 awdiary fles fike pagefie sys, hibedi sys sle ). This wil reduce operation
lime and backup image size

| Automats: BCD update
Add boot entry for target partition to BCD hive on copy'restons sounce parition

This section contains a set of options that will be taken into account during copy and backup operations:

HDD raw processing. Mark the checkbox to copy/back up a hard disk in the sector-by-sector mode, thus
ignoring its information structure (e.g. unallocated space or unused sectors of existing partitions will be
processed as well). This can help to avoid problems with hidden data created by certain applications or the
system administrator. However, it will take more time to accomplish the operation.

Partition raw processing. Mark the checkbox to copy a partition in the sector-by-sector mode to successfully
process unknown file systems. However it is not recommended to enable this option when working with
supported file systems as it takes more time to accomplish the operation.

Skip OS auxiliary files. Mark the checkbox to skip OS auxiliary files (like pagefile.sys, hiberfil.sys, etc.), thus
reducing the operation time and the resulted size of the backup image.

Automatic BCD Update. Unmark the checkbox to suppress automatic update of BCD (Boot Configuration Data)
after copy/restore operations.
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Hot Processing Options

V| Enable hot processing

Hot processing technology
Microsoft Volume Shadow Copy Service E]

Microsoft Volume Shadow Copy Service is a relisble technology designed to back
up volumes being locked by numerous active transactions of VSS suppoting
applications. Microsoft VSS technology requires over 300 MB of free space on
any mounted NTFS volume for temporary data. This technology is provided for
Windows XP and newest Windows versions, but unavaiable for old versions of
Windows (S8/ME/NT/2000)

Addtional options

Always use hot processing

@ Use hot processing only when partition is locked

Hot procassing temporary dive

5

Number of attempts to stat VSS: 3

Timeout batween attempts §n seconds). 120
V| Switch between Hot Procassing technologies

In this section you may configure the hot processing mode:

Enable hot processing. Mark the checkbox to enable the so called hot data processing mode that is specially
designed to process data without restarting your operating system.

Hot processing technology. From the pull-down list you can select the required hot processing technology.

Always use hot processing. Select the option to process partitions without making them locked. Thus you will
be able to keep working with them as usual.

Use hot processing only when partition is locked. Select the option to use the hot processing only when
partitions are locked and cannot be processed without restarting the computer. Please keep in mind, that once
you start any operation on a partition in this mode, it will automatically be locked by the program, thus you
won't be able to keep working with it as usual.

Hot processing temporary drive. Here you can select a disk drive that will be used to store the temporary hot
backup data (by default — C:).

Attempts to start VSS. Here you can set how many attempts to start Microsoft VSS the program is to do before
automatically rebooting the system and accomplishing the operation in a special boot-up mode.

Timeout between attempts (in seconds). Here you can set a time period between different attempts to start
Microsoft VSS.

Switch between hot processing technologies. Mark the checkbox to automatically switch between Paragon Hot
Processing and Microsoft VSS if one of them is unavailable at the moment.

Partitioning Options

Corfimations
| Ask for volume label before parition dalate

Ask confirmation wien converting FAT16to FAT32.

This section contains a set of options that will be taken into account during partitioning operations:

Request confirmation before partition deletion. Mark the checkbox to activate an additional security
mechanism. Thus when going to delete a partition you will be automatically requested to enter its label.
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e Request confirmation when converting FAT16 to FAT32. Mark the checkbox to automatically request
confirmation before converting FAT16 to FAT32. There are a number of situations when this kind of conversion
is the only way out to accomplish the operation. For instance, you are going to migrate your system to a larger
hard disk with the proportional resize of existing partitions, what is very convenient. As a result you can get
original FAT16 partitions go beyond the 4GB limit. Thus without conversion to FAT32, this operation will in no
way be possible to accomplish. The same goes for any copy hard disk/partition or restore hard disk/partition
operation involving an extra upsizing.

Virtual Mode Options

Operations mode
J| Alow vitual mode

Set this option on to cany out all the operations vitualy. You will be able to
commi the changes or rolback al of them or the last one. ¥ you switch this
option off, the operations will be camed out immediately

Close progress dialog automatically
Set this option on to automatically close the progress dialog after commiting the
changes

In this section you may configure the virtual mode:

e Allow virtual mode. Mark the checkbox to enable the virtual mode. It is an effective way of protection from any
troubles, since no operation will be executed until confirmation, thus giving you a second chance to weigh all
pros and cons of this or that particular operation.

[D We strongly recommend you to enable this mode.

o Close progress dialog automatically. Mark the checkbox to automatically close the progress dialog after
accomplishing operations.

File System Conversion Options
Ng File system conversion options

Sedact a time zone

{GMT) Greenwich Mean Time: Dublin, Ednburgh, London, Lisbon (v
Select language for file names
Englsh (CP-850) !

This language wil be used to spacfy national symbols in file names

Confirm settings before NTFS <> FAT/FAT32 conversion

Choose this option to make the program to allow 10 customize these settings each
time when converting fie systems

This section contains a set of options that will be taken into account when converting FAT and NTFS file systems. By
default, the program takes locale (regional) settings from the system. Problems might occur however because of
different standards for file names and file time stamps (Created, Modified and Last Access Time) of NTFS and FATxx file
systems.

To tackle problems of that kind you can manually set:
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o Time zone to use during the convert operation. NTFS keeps file timestamps in GMT (Greenwich Mean Time)
while FAT uses a fixed local date and time. The program takes proper account of these differences and enables
to adjust timestamp values.

[D An incorrectly chosen time zone might lead to inability to launch certain software.

e Language for file names to use during the convert operation. NTFS stores file names in Unicode while
FAT/FAT32 uses ANSI to save short file names (also called the DOS aliases). The codepage information is
required for the correct conversion of non-English file names from Unicode to ANSI and vice versa.

(D An incorrectly chosen codepage will certainly result in corruption of non-English file
names.

e Request confirmation of settings before NTFS < - > FAT/FAT32 conversion. Mark the checkbox to automatically
display the local settings dialog to check and modify (if necessary) the default parameters before launching the
convert file system operation.

Log Files Options

I'U_E Log files options

Choose a storage ife span for the stubact Jog file. Please nate, once the defined pesiod
hias bean eqpirad, the: fils will be smptied.
@ Infinde
Marurnal

Custom

In this section you can specify a storage life span for the stubact.log file:
o Infinite not to empty the file ever;
e Minimal to have the file emptied all the time;

e Custom to set a certain storage life span for the file. Please note, once the defined period has been expired, the
file will be emptied.

We strongly recommend you not to choose the Minimal option, as in case of having
@ problems with the program, our Support Team won’t be able to study operation logs, thus

help you out.

Viewing Disk Properties

The main tool to view in-depth information on the properties of hard disks is the Disk Map. It represents the actual state
of the computer’s hard disks.
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Generally the hard disks are represented on the map by rectangular bars, which also contain small-sized bars. The small-
sized bars represent logical disks (partitions). When you select a large-sized bar, the Explorer Bar displays information
about the disk in a bright, graphical form.

' Basic Hard Disk 1 {FUJITSU MPF3102AT)

Type: Basic Hard Disk Drive
Total size: 35GB
Sectors per track: €3
Heads: 295
Cylinders: 1245

Create an image of the entire disk
r Back up &l the data this haed disk contains. All the partiions on this disk will be added to the archive,

Rest an_im the entire disk
Warning: This operation wil delete all the data on this haid disk. All the pattitions will be replaced with cnes from
the image you have chasen. You may also be asked to restaet your computer during thes operation

Copg the entire hard disk
@ Create a copy of the entire haed disk

Al the patitions on this disk wil be copiad on the specified targat disk.

The model and serial number of the disk serve as the title of the browsed page. The disk layout is shown in form of a
circular graph, where the color of a sector corresponds to a file system of an appropriate partition. On the right you may
see a table, which contains the following information:

e Type of hard disk (basic or dynamic),
e Total size (in GB),
e Information on geometry of the disk (amount of sectors per track, heads and cylinders).

Below there is a list of available wizards. If you click a corresponding record the appropriate wizard will be started. All
default values for the operation parameters will correspond to the disk’s settings. The list of wizards contains a detailed
description of tasks that can be performed by the wizard. This nullifies the possibility of selecting the wrong wizard.

' Logical Disk (G)

Volume letter: [G:) Serial number: 7493E48F
Volume label: FAT32-LINLX Partition ID: 0:08 FAT32
Type: Primary Total size: 63GB
File system; FAT32 Used space: 57GB
Sectors per boot: 36 Free space: 1GB
Sectors per cluster: 8 Activity: Inaclive

Hidden state: Not hidden

A Create an imaqe of the logical disk
g Back up all the data this logical disk contains.

Warning: This operation will delete all the data on this logical disk and replace them from the image you have
chosen. You may also be asked to restat your computes during this operation.

Copy the selected partition
Create a copy of the paitition. A new pastiion will be created and all the data wil be copied there,
‘You can create an exact copy, of copy only the area that is occupied by data.

g Restore the logical disk from an image
4

&
When you select a small-sized bar (i.e. corresponding to a logical disk) the Explorer Bar will display information on it as
well. The page title will contain a drive letter, which is assigned to the disk. The disk layout graph will be colored in
accordance with the volume ratio of the used space to the free space (the light colored sector). The table on the right
will contain the following information:
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e Volume label (if available),
e Type of the logical disk,
e File system (represented by the color of the graph and the selected bar),
e Total size, used space and free space (in GB or MB).

Below there is a list of wizards, which may be called for this disk. All default values of parameters will correspond to the
disk settings.

Partition Management

In this chapter you will find all the information necessary to carry out partitioning operations supported by the program.

Basic Partitioning Operations

Here you can learn how to accomplish basic partitioning operations (create, format, delete).

Creating Partitions

The program provides the ability to create a new partition within a block of un-partitioned space.
Restrictions
1. Do not use the Create Partition function in order to undelete the last deleted partition.

2. The program allows creating new partitions only within blocks of un-partitioned space. It cannot convert a free
space on an existing partition to a new partition.

3. The program cannot create new partitions on Dynamic Disks.
Express Create Partition Wizard Startup

e Inthe Main menu: select Wizards > Express Create Partition...

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

Dialog Startup
1. Select a block of free space on the Disk Map;

2. Select in the Main Menu: Partition > Create Partition.

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

Express Create Partition Wizard Setup

Thanks to a highly intelligent work algorithm, the wizard requires minimal involvement in the operation, thus you only
need to choose a method you find the most suitable to create the partition (if several available), which actually differ in
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the amount of space to allocate. For easy perception, you can see the resulted disk layout on the disk map by selecting
this or that mode.

The result you will get sfter applying the changes
Basic Hard Disk 0 (VMware, VMware Virtual S SCS| Disk Dev)

lq_))locdf)vsk((l) lq_ydd.:([) l@ New V

SGEN

Please select the method of new partition creation
Smart Mode (Usa 182.1 GBto craate a parttion ) More nfo

@ | Advanced Mode | (Use 108.5GEto create 3 patition ) Mere info

The number of available methods depends on your disk layout.

To learn more on the way the wizard works, please click the corresponding link on the first
page of the wizard.

Dialog Setup

Initially the program suggests some consistent values for all parameters. In most cases, you can just press the Yes
button to confirm the operation.

(-9 sl
Are you sure you wanl lo crealte a new parlition on disk 37
You are about 1o create a new partiion in (Unallocated). 19.9 GB area. Please select size.
position and file system of the new partition.
Basic Hard [Dizk 3 (WMware, VMware Vitual 5 5051 Disk Dev)
I I &) New Volume (H:) I
19.9GE NTFS
Create new partiion as: Primasy partiion [
Flease spacify new partibon size:; 20473 - TMB-20473 MB
Please specty sire of free space befors the patiton: 0 % [MB - 20,465 ME
Please specify size of free space afterthe patition: = DMEB-20472 MB
Flease select file system for new parition: | NTFS [=]
Flease enter new volume label: Hew Voluma
Flease spacify dive letter H El
=) [More options l Yes ][ Mo ]

o Define whether the partition will be Primary, Extended or Logical. You can choose the desired partition type
from the pull-down list. As a matter of fact, the available alternatives fundamentally depend on the selected
block of free space - within the Logical free space, only Logical partitions can be created; Within the Primary free
space, both Primary partitions or the Extended Partition can be created.

e Partition Size. Define the size (in Mb) of the new partition.
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o Free space before. Define the position (in Mb) of the new partition relative to the beginning of the block of free
space.

e Free space after. Define the amount of trailing free space (in Mb) at the end of the new partition.

that, just carry out the required operation on the Disk Map. The virtual operations are to be

o Partition size and position may also be defined by using the drag-and-drop technique. To do
available.

o File system for new partition. From the pull-down list select a file system the newly created partition will be
formatted to, otherwise the partition will remain unformatted (so that it will not be ready to use).

e Volume label. Enter a label for the selected partition in this textual field. It is an irrelevant parameter usually
used for drive identification.

e Drive letter assignment. The pull-down list contains vacant drive letters that can be associated with the newly
formatted partition.

In addition, there is the possibility to make further detailed settings (although the default values will do in most cases).
To activate the advance mode, you need to click the More options button at the foot of the dialog page. Depending on
the chosen file system, the following options become available:

V| Use 05 buik in format routine
Please select number of sectors per chuster: | § [
Restore defaulls

e Use OS built-in routine. Mark the option to restrict the available values according to the used OS.

o The amount of sectors per cluster. Define the Cluster Size for the formatted partition with this spinner control.

o Number of available options depends on the selected file system type.

Result
After the operation is completed you receive a fully functional partition.
Available operation scenarios:

e (Creating a new partition to detach operating system from the rest of data

Formatting Partitions

Any partition should contain some file system to be used for keeping data. The process of installing a file system is
commonly known as formatting. A huge variety of file systems have been developed these days.
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Supported File Systems
The program provides the ability to format partitions of the following file systems:
- FAT12 & FAT16
- FAT32
- HFS+
- NTFS

Wizard Startup

e In the Main menu: select Wizards > Format Partition...

There are other ways to start up this function, please consult the Interface Overview

chapter to know more on the subject.

Dialog Startup
1. Select a partition on the Disk Map;

2. Select in the Main Menu: Partition > Format Partition.

There are other ways to start up this function, please consult the Interface Overview

chapter to know more on the subject.

Wizard Setup

The wizard offers the following steps to accomplish the operation:

e Partition to format. Select a hard disk (if the computer has several hard disks) and then the required partition to
format.

On this page, you can choose a volume you would like to format

Basic Hard Disk 0 (VMware, VMware Virtual S SCS1 Disk Dev)
[I«a Local Disk (C:) deaa(z;)
217GB NTFS

2829 GB NTFS
Basic Hard Disk 1 (VMware, VMware Virtual S SCSI Disk Dev)

l @) Local Disk ()
439.3GB NTFS

Basic GPT Hard Disk 2 (VMware, VMware Virtual S SCSI Dysk Dev)

I l '_)) (Unallocated)

[D As a result of this operation contents of the selected partition will be lost.

Copyright© 1994-2013 Paragon Software GmbH. All rights reserved.



28

e Partition properties. On the next page of the wizard you can set the following partition parameters:
Your hard disk: after the changes
Basic Hard Disk 0 (WVMware, Viware Vidual 5 SCS1 Disk Dey)

I @) Local Disk (C:) I @) data (Z:)

olume labal: | Mew Valuma
- Partition type. From the pull-down list select the desired file system type. In fact, the program displays only
those file systems that can correctly be placed to the selected partition, taking its capacity into account.

- Volume label. Enter a label for the selected partition in this textual field. It is an irrelevant parameter usually
used for drive identification.

- Drive letter assignment. The pull-down list contains vacant drive letters that can be associated with the newly
formatted partition.

In addition, there is the possibility to make further detailed settings (although the default values will do in most cases).
To activate the advance mode, you need to mark the appropriate option at the foot of the page. When it is marked, the
next page enables to define:

7] [Use 05 but in fomat routine |

Pisase salact sectorns par Clustar

2 [+
e Use OS built-in routine. Mark the checkbox to restrict the available values according to the used OS.

o The amount of sectors per cluster. Define the Cluster Size for the formatted partition with this spinner control.

Number of available options depends on the selected file system type.

Dialog Setup

Initially the program suggests some consistent values for all parameters. In most cases, you can just press the Format
button to confirm the operation.

ECE )

: * Are you sure you want to format volume (F:)?

You are about to format volume (F:) [No label]. NTFS. Your computer may
no Jonger boot or work comectly

Please select new fie system:  [ZNENNN )
Please enter new volume label: | New Volume

¥) More options | Foemat 1 No

o File system. From the pull-down list select the desired file system type. In fact, the program displays only those
file systems that can correctly be placed to the selected partition, taking its capacity into account.
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o Volume label. Enter a label for the selected partition in this textual field. It is an irrelevant parameter usually
used for drive identification.

In addition, there is the possibility to make further detailed settings (although the default values will do in most cases).
To activate the advance mode, you need to click the More options button at the foot of the dialog page. Depending on
the chosen file system, the following options become available:

o Use 05 buik in format routine
Fleass select number of sectors per cluster: | 8 [ =]
:Haﬂmdd’us.
e Use OS built-in routine. Mark the checkbox to restrict the available values according to the used OS.

e The amount of sectors per cluster. Define the Cluster Size for the formatted partition with this spinner control.

o Number of available options depends on the selected file system type.

Result

After the operation is completed you receive a fully functional partition formatted to the specified file system.
Deleting Partitions
Wizard Startup

e |nthe Main menu: select Wizards > Delete Partition...

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

Dialog Startup
In order to start the operation you should take the following steps:

Launcher
1. Select a partition on the Disk Map;

2. Select in the Main Menu: Partition > Delete Partition.

chapter to know more on the subject.

o There are other ways to start up this function, please consult the Interface Overview
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Wizard Setup

The wizard offers the following steps to accomplish the operation:

e Partition to delete. Select a hard disk (if the computer has several hard disks) and then the required partition to
delete.

On this page. you can choose 3 volume you would ike o delete
Basic Hard Disk 0 (VMware, VMware Virtual S SCS1 Disk Dey)

.t_)}Locdllnk(C:) lq_;,daa(z:)
282.3GB NTFS 217GB NTFS

Basic Hard Disk 1 (VMware, VMware Virfual S SCS1 Disk Dev)

I ©) Local Disk (°) 3
4333 GBNTFS

Basic GPT Hard Disk 2 (VMware, VMware Virtual S SCS1 Disk Dev)

l I @) (Unallocated)
5698 GB

/ ! You are sbout 1o destroy a bootable partition!
AL\

As a result of this operation contents of the selected partition will be lost.

o Merge free blocks. As a result of the operation you may get several blocks of the unallocated space on the hard
disk. So choose whether to merge them all and place at the beginning of the disk or at the end by selecting the
required operation from the pull-down list.

Merge fres blocks options
Do mot marps fres blocks s, |:|

Marge fraa blozks & the and o the disk

. Do ot merge free bocks
Merpe fres blocks at the beginning of the disic

Dialog Setup

Initially the program suggests you just to remove references to the selected partition from the Partition Table.

%

P

Q"Z» Are you sure you want to delete volume (F:)?

w You are about to delete volume (F:) [No label]. NTFS. Your computer may
no longer boot or work comectly.

7)[Do ot ask volume label next time |

e Enter the volume label to confirm deleting. To confirm deletion of the selected partition, enter its Volume
Label. The current volume label is displayed above.

¢ Do not ask volume label next time. Mark the option to inhibit confirmation next time you start the dialog.
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Result

By default, the operation takes only a fraction of a second. However, the program waits until Windows completes the
modification of the disk layout.

Advanced Partitioning Operations

Here you can learn how to accomplish advanced partitioning operations.

Moving/Resizing Partition
The Move/Resize Partition function allows you to resize or change location of any partition without destroying its data.

In order to move/resize a partition you should take the following steps:
1. Select a partition on the Disk Map.

2. Select in the Main menu: Partition > Move/Resize Partition...

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

3. Define parameters of the operation.

% Are you sure you want to move/resize system volume (C:)?
4 You are about 1o move/resize NTFS volume [No label), (C:)
Basic Hard Disk 0 (VMware, VMware Virtual S SCSI Disk Dey)

lt_)/Locled((C:)

2829 GB NTFS

Volume size 283776 M8 +[] 11.823MB - 289,721 MB
Frea space befora. 037 MB ) [:—E O bytes - 277.850.73 MB

Fres space after. 485 MB 8 [T_] 0 bytes - 277,850.76 MB

Sectorto sector move
Salect this option to move parttion amas that dont contan any data. This allows you to
keap the patition’s content after move exactly as t was, but wil raquirs mora time

e Volume size. Define size (in Mb) of the modified partition.

e Free space before. Define the partition position (in Mb) relative to the beginning of the available range of
disk space.

e Free space after. Define the amount of trailing free space (in Mb) at the end of the available range of disk
space.
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e Sector to sector move. Mark the checkbox to move the partition in the sector-by-sector mode to process its
unused space as well. This can help to avoid problems with hidden data created by certain applications or
the system administrator. However, it will take more time to accomplish the operation.

Partition size and position may also be defined by using the drag-and-drop technique. To do
that, just carry out the required operation on the Disk Map. The virtual operations are to be
available.

When resizing a FAT16 partition beyond the 2GB limit (maximum file system size), the
partition will automatically be converted to FAT32.

The program enables to enlarge NTFS partitions (system, locked) without rebooting
Windows and interrupting its work, providing 100 percent guarantee that your data is kept
intact.

4. The operation will be performed immediately after confirmation.

Available operation scenarios:

e Increasing size of a system partition by taking unused space from any other

Converting File System

With our program you can change type of the used file system without destroying its data. While performing the
operation, it first checks the current file system for consistency and then verifies whether the on-partition data meet the
requirements of the desired file system or not. After having passed the testing, the program re-organizes the file system
metadata and user files.

The program enables to convert the following file system types:
- FAT16/32 <> NTFS

In order to convert a file system you should take the following steps:
1. Select a partition on the Disk Map.

2. Select in the Main menu: Partition > Convert file system...

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

3. Initially the program suggests some consistent values for all parameters. In most cases, you can just press the
Convert button to confirm the operation.
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EE

@\ Are you sure you want to convert system volume (C:)?

¢ New file system. From the pull-down list choose a file system you would like to convert to. Actually the
program only displays variants available for the operation, taking into account the current parameters of the
selected partition and limitations of the used file system.

e New cluster size. Define the cluster size for the partition. This parameter can have a profound effect on the
overall performance. In a nutshell, larger clusters waste more space, but generally provide for slightly better
performance, because of less fragmentation. So be particularly careful with it.

The cluster size value is expressed in sectors per cluster. To get it in Kbytes, please divide it
into half.

You may only decrease the current cluster size.

o Surface test level. Define the level of the surface check to make the program find bad and unstable sectors
and mark them unusable in the file system metadata.

4. The operation will be performed immediately after confirmation.

Changing Partition Attributes

This chapter explains how you can change partition attributes (Active flag, Hidden flag, Volume Label, etc.).

Mark Partition Active/Inactive

The program enables to set an active/inactive flag for primary partitions of a hard disk. By default, an operating system
will boot only if its partition is active or bootable.

In order to mark a partition active/inactive you should take the following steps:
1. Select a primary partition on the Disk Map.

2. Select in the Main Menu: Partition > Mark Partition as Active/Inactive.

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.
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o s
i Are you sure you want to set the volume as active?

You are about 1o set the volume (F:) [No label]. NTFS as active. ¥ you already
have active volumes, this action might render your system unbootable

Yes , No

3. The operation will be performed immediately after confirmation.

There can only be one active partition on a hard disk, otherwise your operating system will
fail to boot.

Hide/Unhide Partition

The program allows you to hide/unhide primary and logical partitions. By default, an operating system does not mount
hidden partitions, thus preventing access to their contents.

In order to hide/unhide a partition you should take the following steps:
1. Select a partition on the Disk Map.

2. Select in the Main Menu: Partition > Hide/Unhide Partition.

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

3. The operation will be performed immediately after confirmation.

It is strongly recommended not to hide the system partition. Otherwise your operating
system will fail to boot.

Set Label of a Partition

The Partition Label is a small textual field (up to 11 characters) that is located in the partition's boot sector. It is
detectable by any partitioning tool and is used for notification purposes only.

In order to change a partition label you should take the following steps:
1. Select a partition on the Disk Map.
2. Select in the Main Menu: Partition > Modify > Change Volume Label.

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

3. Enter alabel for the selected partition.
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R ===
® Are you sure you want to change label on volume (F:)?
! Please specify a volume label for easier recognition of your volume

Please enter new volume labed: | New Volume

Yes ; No

4. The operation will be performed immediately after confirmation.

Hard Disk Management

In this chapter you will find all the information necessary to carry hard disk operations supported by the program.

Updating MBR

The program enables to overwrite the current bootable code in the MBR (Master Boot Record) by the standard
bootstrap code. This can help to repair a corrupted bootable code of a hard disk resulted from a boot virus attack or a
malfunction of boot management software.

In order to update MBR of a hard disk you should take the following steps:
1. Select a hard disk on the Disk Map.
2. Select in the Main Menu: Hard Disk > Update MBR.

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

7 s
" Are you sure you want to update master boot record?
£=2 Cument MBR contents for hard disk number 0 wil be lost after this operation. Your

computer may no longer boot comectly
‘ Yes I ‘ No

3. The operation will be performed immediately after confirmation.

Extra Functionality

This chapter describes the supplementary functionality available in the program.

View Partition/Hard Disk Properties

The program enables to obtain in-depth information on the properties of hard disks and partitions. Besides the general
information, such as capacity, used space or file system type it provides the possibility to get info on hard disk geometry,
cluster size, exact partition location, etc.

To get properties on a partition/hard disk, please do the following:
1. Choose a partition/hard disk on the Disk Map.

2. Select in the Main Menu: Partition/Hard Disk > Properties...
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There are other ways to start up this function, please consult the Interface Overview

chapter to know more on the subject.

' [Geneal File System Info l Advanced

Local Disk (C:)

Volume: label:  [No lsbel)
File system: NTFS
Type: Primary
Capacity: 4393GB
536.868,814.848 Bytes
1.048.571,904 Sectors
Used by data: 953GB(1%)
10,016,497 664 Bytes
19.563.472 Sectors
Free space: 4306GB (39%)
526.852,317,184 Bytes
1.029.008,432 Sectors

In the opened dialog information will be grouped according to its properties, thus by clicking tabs you can get
information you need.
Mount Partition

The program enables to assign or remove drive letters of existing formatted partitions.

Assign Drive Letter
In order to mount a partition you should take the following steps:
1. Select a partition on the Disk Map.

2. Select in the Main Menu: Partition > Assign Drive Letter...

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

3. Specify a drive letter for the selected partition. Initially the program suggests some consistent value for this
parameter. So you may just press the Yes button to confirm the operation.
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0]

@\ Assign a drive letter?

1 This allows access to the volume by using the drive letter assigned. The
assignment is not recommended f the volume contains a file system not
supported by your operating system

Assign the folowing drive letter: [N ~ |

However you can manually define the required letter by selecting it from the pull-down list of available drive
letters.

4. The operation will be performed immediately after confirmation.

Remove Drive Letter
In order to un-mount a partition you should take the following steps:
1. Select a partition on the Disk Map.

2. Select in the Main Menu: Partition > Remove Drive Letter.

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

3. The operation will be performed immediately after confirmation.

Modifying drive letter of the system partition will result in inability to boot the operating

system.
After having processed partitions with installed software, some programs may not run
properly.

Test Surface

The program enables to test surface of existing partitions and blocks of free space for bad or unstable sectors. If found
any it automatically marks them unusable in the file system metadata, thus minimizing the risk of data loss.

In order to start the surface test you should take the following steps:
1. Select a partition or a block of free space on the Disk Map.

2. Select in the Main Menu: Partition > Test Surface...

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

3. From the pull-down list choose the level of the surface check.
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[ % |fetm)

% Test surface of volume (C:)?
Testing volume suface allows 1o find bad blocks and other peoblems
Please select 3 suface tezt level: [ ~ |
[ Ye J[ M

4. The operation will be performed immediately after confirmation.

Check File System Integrity

The program allows you to check integrity of a file system. It can be used to detect possible file system errors before
performing any operation on a partition.

To start the system integrity check you should take the following steps:
1. Select a partition on the Disk Map.
2. Select in the Main Menu: Partition > Check File System Integrity

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

[ )
Q Check volume (C:) [No label]. NTFS for errors?

Please note that check operation needs exclusive access to the volume. You may be
asked to restart your computer to complete the operation

|

3. The operation will be performed immediately after confirmation.

View Logs

With a handy dialog you can study logs on any operation carried by the program. To make this job as easy as possible, all
the information is structurally divided, besides there is the possibility to see the disk layout before and after an

operation, what is very convenient.

In order to view logs on carried out operations select in the Main Menu: Tools > View Log Files
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= 0 ¥ &YV (=

h"f_'.__
Session event
Started 9732000 at 12-40-45 AM. Frished at 12:41:21_..
Started 97320009 at 12-42:11 AM. Fnished at 12:44:29_.
Started 9732000 at 12-45:04 AM. Frighed at 124512
¥ Started 932009 ab 12-45:39 AM. Freshed at 1:28:51
¥ Started 3272009 at 9:17:40 AM. Finished ab 3:21:28 AM
o Started 9272009 at 9:30:36 AM. Finished at 3:41:04 AM
8 Sarted 322009 at 9:41:05 AM
5 Started 3272009 at 12-1%:43 PM. Frished at 12-20:26...
¥ Sared 322009 ab 12-20:26 PM. Frished at 12:24:46...
8 Started 3272009 at 12-24:45 FM
¥ Started 3272009 at 12-06:15 PM. Fnished at 12-07-47 ..
v Sarted 3272009 at 12-07-47 PM. Frished at 12:21:18...
¥ Sared 322009 a 12-21:18 PM. Fnished at 12:30:15...
Started 3722009 at 12-30:15 PM. Finished at 123133,
Started 3220009 at 12-31:33 PM. Fnished at 12:41:47...
Started 3722009 at 12-44:44 PM. Fnished at 125838
B Sated 3722009 a 1:08:03 FM

Basic Hard Disk 1 (Viware, Viware Villual 5 SC51 Diske Dey) - OF

.@w
FREE

Basic Hard Disk 2 (ViMware, Viware Vidual 5 SCS1 Diske Devy) - OF

.gwmm
FREE

No operations have besn found for the sslected session.

Dk Syton Conpraton A Seson
Basic Hard Disk 0 (Viware, Viware Vidual 5 SC51 Diske Dev) - OF Basic Hard Disk 0 (ViMware, Vilware Vidual 5 SC51 Diske Dev) - OF
W () W (C)
NTF5 NTF5

Basic Hard Disk 1 (Viware, Viware Vidual 5 SC51 Diske Dev) - OF

.‘i!'w
FREE

Basic Hard Disk 2 (ViMware, Viware Vidual 5 SCS51 Diske Dev) - OF

.@wmm
FREE

Typical Scenarios

This chapter lists a number of the most frequently used scenarios that may be accomplished with the program. You can
find here useful recommendations and descriptions of operations.

Resize Scenarios

Creating a new partition to detach operating system from the rest of data

Let’s assume that you’re a rank and file user who is most likely to have only one hard disk with only one partition (the
only partition is always system). To secure yourself against a system malfunction or a virus attack you’ve got nothing to
do, but make a backup of the whole partition, which besides the operating system itself contains all your family photos,
favorite films and music, program distributives, whatever. As a result you’ll get a very huge backup image. You can easily
tackle this issue however by detaching your operating system from the rest of data.

To create a new partition on your hard disk, please do the following:

1. Click the Express Create Partition item of the Wizards menu.

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.
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2. Onthe Wizard's Welcome page, click the Next button.

3. Choose a method you find the most suitable to create the partition. The wizard is especially designed to
minimize your participation in finding an appropriate place for it and its resulted size. The only thing you’re to
do is to choose between several modes. The most relevant thing here is the amount of space that will be

allocated for that partition. For easy perception, you can see the resulted disk layout on the disk map by
selecting this or that mode.

The resut you will gat after applying the changes

Basic Hard Disk 0 (VMware, VMware Vidual S SCSI Disk Dey)

. I @) New Volume (E:)

Plaase salact the mathod of new panttion craation
Take all unallocated space at the end of the disk
©) | Smart Mode | (Use 2433 GBto create a pattion ) More nfo

Advanced Mode [ llsa 141 4GB0 craate apantton ) More nfo

The number of available methods depends on your disk layout.

To learn more on the way the wizard works, please click the corresponding link on the first
page of the wizard.

4. That's basically it. By clicking the Next button the wizard will start modifying your disk layout. If you've got to do
with the system partition resize, like we do in our case, you will be asked to restart your computer in a special
boot-up mode to accomplish the operation. So click the appropriate button to agree.
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;__Q Express Create Partition Wizard ? 53
Creating the partition :Q‘
The Wizard is now creatng the pantion .

Crests sastion

._9 Express Create Partition Wizard rv-?’—‘l

6 System restart is required to complete the operation.
/ =\ What would you like to do?

The operation Move partition needs axclusve access 1o the volume C: and
Opartio cannct be completed without system restad. After restant, the operation will continue in
= boot4me mode. Do not tum off the computer until the operation
completes.

5> Restart the computer
Please confirm restart of your computer. The operation will be continued after
system restant

& Retry

Manually closa usad filas and ratry tha oparation

) Ve Tha cparation cannot be complatad wihout rastat bacause some fiss are in use and
\ St \i) pravent axclusive access to the volume

What fles prevent cpention completion?

5. Inthe Progress window you can see in real-time a detailed report on all actions carried out at the moment.
After completing the operation your computer will be automatically restarted back to Windows where you can see the
newly created NTFS partition. Now you’ve got a place to keep your stuff apart from Windows.

Increasing size of a system partition by taking unused space of an adjacent partition

Let’s assume you've got several partitions on your hard disk. After installing a number of resource-consuming
applications and system updates your system partition has started to suffer from the lack of free space. But an adjacent
partition has a plenty of redundant space. That’s just enough to make your system partition suffer no more.

To increase size of a system partition by taking unused space from an adjacent partition, please do the following:

1. Click the Express Resize Partitions item of the Wizards menu.

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

2. Onthe Wizard's Welcome page, click the Next button.

3. Click on your system partition. By doing that, the wizard will automatically select an adjacent partition as well.
This partition will later act as a space donor.
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The wizard will resize space between Local Disk {C:) 2nd New Volume (E:)on Basic Hard Disk O
(Whware, VMware Vitual 5 5C51 Disk Dev)

Selact laft partition from 2 pair of adacent paritions you would ke to resize, Right adiacent parttion will ba
selected automatically

Basic Hard Disk 0 (VMware, VMware Virtual S SCS1 Disk Dev)

nl @) New Volume (E:)
460 3 GB NTFS

If you’ve got more than two partitions on your hard disk and a partition you need to
increase is surrounded by other partitions, you’ve got the choice to choose which partition

will act as a space donor. Just click on the left partition of the pair, as the right one will be
selected automatically.

4. Increase size of the system partition with the slider or manually by entering the required value. Please note,
when you change size of one partition the size of the other will be changed as well, thus redistributing the
unused space between the partitions.

Plaasa spacfy new szes of salacted patitons
Selected part of Basic Hard Diske 0 (WMware, VMware Virtual 5 SC5] Disk Dev)
l l € New Volume (E:)
Laf wolume size Right voluena size
4pE24ME |5 MB —{] sTIEEME 2| MB
5. On the next page of the wizard you need to confirm the operation by selecting the appropriate option.
The \Wizard has not applied your changes yet. On this pags, you can aither accapt or
reconsider the changes
Please note that # you accept the changes. the Wizard wil physically pefom ol the neccessary
operations and & will not be pessble to undo the changes
Rt may take some time to apply the changes. You may also be asked to rastat your computer duning this
process
VWould you ke to apply your changes 7
Yes. spply the changes physicaly
© [No. let me reconsider |
6.

That’s basically it. By clicking the Next button the wizard will start modifying your disk layout. If you’ve got to do

with the system partition resize, like we do in our case, you will be asked to restart your computer in a special
boot-up mode to accomplish the operation. So click the appropriate button to agree.
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".; System restart is required to complete the operation.
/= What would you like to do?

The operation Redistribute partitions nesds exclusve access 1o the voluma C:
and cannat be complated without system restant, After restan, the operation wil
cortifug in bostdme made. Do not tum off the computer until the operalion
completes.

. Restarl the computer
Pleass corfim resten of your computer. The cperstion will be continued after |
syshem resan |

&> Retry
Manualy close used filas and relry the operation

[ et ]

In the Progress window you can see in real-time a detailed report on all actions carried out at the moment.

After completing the operation your computer will be automatically restarted back to Windows where you can see that

your system partition is bigger now.

Increasing size of a system partition by taking unused space from any other

Let’s assume you’ve got several partitions on your hard disk. After installing a number of resource-consuming

applications and system updates your system partition has started to suffer from the lack of free space. But one of your

partitions has a plenty of redundant space. That’s just enough to make your system partition suffer no more.

To increase size of a system partition by taking unused space from any other on-disk partition, please do the following:

1.

2.

In the main window select the required hard disk (if several) on the Disk Map.

|| B8l [5) Basic GPT Hard Disk 2 (VMiware, Viware Vintual S SCS1 Disk Dev)
6 Local Disk (7 oh
€ (Unalocated) 473BFFBDA

(BﬂcHﬂdMO(Vme.V“mWSKZSID*Dev)

i Al Data (F:) TEMP (G:)
| 10., 200GEB NTFS 160.2 GB FAT22

S

IFI8
s
| =
!
.
-

Choose a space donor partition and then call the context menu for it (right click of the mouse button) to launch
the Move/Resize dialog.
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i Back Up Partiton...
Burn Partston on €0 or DVD...

Teols Changes Wizards Hard Disk Partition Archives Vi Restore Partition,..
@ & % ’:__}'_ 6 t_ﬂ' Format Partition...
| Disk View | Scheduled Tasks | Archives | Help | Delete Partition...
ol Mame . Move/Resize Part'tl'm‘. |
"I [E] Basic Hard Disk 0 (WMware. Vibwane Vitual S SC5I Desk Dev Convert File System...®
: B Local Disk (T)
) i Change Volurne Label...
& “opbeations (E) z C
= [ Edencdad Partition fmm& E_]'_“E =
E Data (F-} Hide Partition
@TEIJP G Make Partition Primary
il [] Basic Hard Diskc 1 (Viware, Viware Vitual S SCS1 Diskc Dev Change Cluster Size..
&l E_E:ITLT# . . Viwars Vitual 5 SCS1 D Change Senal Number...
- ._'-'I,Id S & LTINS, VTR NI 2 o " Change Partition I0...
- ﬁ Local Disk 7
B (Lnalocated) Wipe Partition...

Clear Free Space...

Test Surface...

| DN 5. Check File System Integrity

Basic Hard Disk 0 (VMware, YMware Virtual 5 5C5| Dish Edit/View Sectors...

A || Data (F:) 10 TEMP '. Properties... i
e 200 GB NTFS || 160.3GB FAT32 | | e ri:

In the opened dialog shift the edge of the partition to the right by the drag-and-drop technique. While doing
this, free space from the partition will be released (displayed in aqua-green). You can also do it manually by
entering the exact size of free space. Click the Yes button to continue.

Are you sure you want to move/resize volume (G:)?

You are about 1o move resize FAT32 volume TEMP, (G:)

Basic Hard Disk 0 (VMware, VMware Virtual S SCS1 Disk Dev)
I @) (Unallocated) .“‘l @) TEMP (G)
1

595GE 00.7 GB FAT22
Volume size: 10316733 M8 #[+] 86 MB- 164.156 MB

Free space before: £0.928.55MB &[] Obytes - 164070.09 M8
Free space sfter. 0 Bypes *[=] Obytes - 164.070.09 M8

Select this option to move partiion areas that dont contain any data, This allows you to keep
the parition’s content after move exactly as & was, but will require more time

Now you’ve got a block of free space to add to the system partition. You cannot do it directly however, but by
carrying out a number of extra move/resize operations.

Basic Hard Disk 0 (VMware, VMware Virtual S SCSI Disk Dev)

A.. ‘ Data (F:) I I TEM...
1. || I8 200GB NTFS . 100.7...
= = =

Since the block of free space is within the extended partition, you need to take it out first. The program enables
to resize the extended partition only when there’s a block of free space adjoining its borders. In our case it’s
between two logical disks. So we need to move it. To do that, please select the first logical partition and then
call the context menu for it (right click of the mouse button) to launch the Move/Resize dialog.
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m* V&ev 'L Scheduled Tldu Move/Resize Partition..*
- e ———————————————— C », \

| Name onvert File System...

4 (5] Basc Hard Disk 0 (VMware, V1 Change Volume Label...
@ Local Dek (C) Remove Drive Letter
g'&“ .'“"': = Hide Partition

5 ¥ Baendad Pattion 3 £
Make Partition Primary
©oes F) 2
@ (Unaliocated) Change Cluster Size...

2 &1ene G) Change Serial Number...
X [E] Basic Hard Disk 1 (VMware, VI Change Partition ID...
. @ Local Dk ) Downgrade NTFS version...
N [5] Basic GPT Hard Disk 2 {VMwat
'Y @Locd Disk (7 Wipe Partition...

e (Unalocated) Clear Free Space...

[ J Test Surface...

‘i Check File System Integrity

Basic Hard Disk 0 (VMware, VI Fdt/View Sectars..

Properties...
Data (F: ) - -
, 200GB NTFS J | . 1007 .. I

6. At first shift the right edge of the partition to the right, then do the same with the left edge. Make sure the
partition size has been left unchanged.

Are you sure you want to move/resize volume (F:)?

7,
9}
= You are about to move/resize NTFS volume Data, (F:).

Basic Hard Disk 0 (VMware, VMware Virlual S SCSI Disk Dey)

©) (Unallocated) ©) Data (F?)
119GB I 1204 GBNTFS ||

Volume size: 123871.14 M8 2[] 94 MB - 265754 MB
Fres space before: |121.523.00MB &[] Obytes - 265,700.04 MB
Free space sfter. 0 Bytes *[] Obytes - 265.700.04 M8

[} Sactorto sactor move

Selact this option to move padition areas that dont contan any data. This allows you to keep
the parttion’s content after move exactly as & was, but will require more time.

7. Now you can resize the extended partition to take the block of free space out of it. Call the context menu for it
(right click of the mouse button) to launch the Move/Resize dialog.

Call a context menu for the extended partition (with the blue border), not the logical one.

8. Inthe opened dialog shift the edge of the extended partition to the right.
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% Are you sure you want to move/resize extended partition on disk 07

 Basic Hard Disk 0 (VMware, VMware Vitual 5 SCS1 Disk Dev)

LN ez ) @) Data (F) @) TEMP (G:)
LEig 1404 GB NTFS 100.7 GB FAT32
Volume size 2¢703860M8 &[+] 247.038 MB - 368,969 MB

Fres space befors: | 121.530.84 ME ;EUHw-ELSEE.E‘MB

Fres space after 0 Bytes 5

L o T e,

Selact this aption to move partition arsas that don't contain any data. This allows you to keep
the partition’s content aftsr move sxactly as & was, but wil regpuins mos times.

9. The block of free space has been released.

Basic Hard Disk 0 (VMware, VMware Virtual S SCSI Disk Dev)
Ap... (Unall...
100. 115GB

10. Now you need to move the second primary partition just the way we did it with the logical partition to make the
block of free space adjoin the system partition.

Data (F:) I TEM...
1404GBNT... || B 1007..

Basic Hard Disk 0 (VMware, VMware Virtual S SCSI Disk Dev)

(Unall... Ap... Data (F:) ITE'"-~
119G8 100 .. 140.4 GB NT... 1007.... |

11. Finally increase size of the system partition. Call the context menu for it (right click of the mouse button) to
launch the Move/Resize dialog.

12. In the opened dialog shift the edge of the partition to the right, thus increasing its size.

','(\9‘ Are you sure you want to move/resize system volume (C:)?
T You are about 1o move/resize NTFS voluma [No label], (C:)

Basic Hard Disk 0 (VMware, VMware Virtual S SCSI Disk Dev)

I @) Local Disk (C:)
152.7GB NTFS

Volume sze 162.547.31 MB #[¥] 11.680 MB - 162,543 MB

Free space before: | 0.57 ME &[] Obytes - 150,868 20 MB

Fres space after. [ Bytes =] Obytes - 150.260.39 MB
| Sectorto sector move

Select this option 10 move pantion aneas that dont contan any data, This allows you to
keep the partion’s content sfter move exactly 3s & was, but will require more time

13. Apply all introduced changes. By default, our program works in the virtual mode of execution, so you have to
confirm all operations to let the program accomplish them. To do that, just click the Apply button on the Virtual
Operations Bar.
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9=
Apply pending changes 7

[k mot show this message again Yes | [ Mo

14. The program will require the system restart to accomplish the operation in a special boot-up mode. Click the
appropriate button to agree.

Resizing partitions of Apple Boot Camp

Let’s assume you're a Boot Camp user who's got Windows XP as the second operating system. Initially allocated space
for the Windows partition has turned out to be insufficient for your current needs. The only way out is to take some
space from your Mac partition, thus redistributing the unused space between the partitions.

To increase size of the Windows partition by taking unused space from the Mac partition, please do the following:

1. Click the Express Resize Partitions item of the Wizards menu.

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

2. Onthe Wizard's Welcome page, click the Next button.

3. The wizard will automatically select Windows (the NTFS file system) and Mac (the Apple HFS file system)
partitions of your Boot Camp configuration.
The vazaed vall iesize space betwesn Local Disk [°] and WinkP [C:) on Hetained Bazic GPT Hard
Disk 0 [VMware Virtual IDE Hard Drive]

Sebact beft parbinon fiom a pair of adjacent partitions pou would ke to resize. Fight adacent patition vall be
zelected automatically.

Retaned Bagic GPT Hard Disk O WM ware Virtual IDE Hard Drve)

Local Disk [*) I I WinP [C:]
54.8 GE Apple HFS

65 GEMNTFS

megabyte free block between Mac and Windows partitions made with Boot Camp. It’s just

o On the disk map you can also see the GPT service partition (called EFI) as well as a 128-
for your information.

4. Increase size of your Windows partition with the slider or manually by entering the required value. Please note,
when you change size of one partition the size of the other will be changed as well, thus redistributing the
unused space between the partitions.
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Please specify new sizes of selected patitions

Selected pat of Retamed Basic GPT Hard Disk 0 [VMware Virtual IDE Hard Drive)

l @) Local Disk () l l ©) WinXP (C:)
' 71.1 GB NTFS

40,2 GB Agple HFS

Left volume size: Right volume s2e;
41250MB S| MB R\‘ 72835MB T MB

On the next page of the wizard you need to confirm the operation by selecting the appropriate option.

. The Wizaed has not apphed pous changea: yet. On thiz page, wou can edher accept o
A reconsider the changes.

Pleass note that if you accept the changes, the Wizarnd will physically pedom al the neccessary
oparations and # vl not be possible to undo the changes.

It miag bake some time to apply the changes. You may also be asked lo restat pour computer dunng this
2=

‘whoudd pou Bke bo apply wour changes 7
(=) | 'f'es, apply the changes physically. |
() Mo, et me reconsidar

That’s basically it. By clicking the Next button the wizard will start modifying your disk layout. If you’ve got to do
with the system partition resize, like we do in our case, you will be asked to restart your computer in a special
boot-up mode to accomplish the operation. So click the appropriate button to agree.

System restat is required o complete the operation.
S = % What would you like to do?

The operabon Hediztnibute partitions needs exchesive access bo the volume C:
and cannot be completed withoul system restart. After restat, the operation il
confinue in boot-lime mode. Do not turn off the computer until the operation
completes.

| Restart the computer
| Please confirm restart of pour computer, The operation will be continued alter
| ihem nestan {

& Retw
Marwally close used fles and ey the operation

In the Progress window you can see in real-time a detailed report on all actions carried out at the moment.

After completing the operation your computer will be automatically restarted back to Windows where you can see that

your system partition is bigger now.

Troubleshooter

Here you can find answers to the most frequently asked questions that might arise while using the program.

1.

| try to run an operation, but the program claims my partition is in use and suggests restarting the computer.

There are a number of operations that cannot be performed while your partition is in use (or locked in other
words). Please agree to reboot your machine to make the program accomplish the operation in a special boot-
up mode.
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2. lrun an operation and restart the machine as required, but it just boots back into Windows without
accomplishing the operation.

Please run 'chkdsk /f' for the partition in question.
3. | cannot create a new partition on the disk.
There can be a number of reasons for that:
e The program cannot create a new partition on a dynamic disk.

e The program allows creating new partitions only within blocks of un-partitioned space. It cannot convert
a free space on an existing partition to a new partition.

4. | cannot copy a partition.
There can be a number of reasons for that:
- The source or target disk you select is a dynamic disk;
- 4 primary partitions (or three primary partitions and an extended one) already exist on the target disk.

5. Ineed to copy a partition. But when selecting a place where to make a copy, | always get a crossed circle sign no
matter which partition is selected.

The program enables to copy a partition only to a block of un-partitioned space. If you don’t have a block of free
space on your hard disk, please delete or reduce an existing partition to accomplish the operation.

6. | cannot do anything with my USB flash drive. | get a crossed circle sign when trying to select any area on it.

Some USB flash drives don't have the MBR (Master Boot Record), that’s the cause of your problem. To fix the
issue please use the Update MBR function of our program or 'fixmbr' of the Windows installation disc to write a
standard code to your flash drive.

7. When trying to back up my system the program asks to restart the computer.
Most likely the Hot Processing mode is disabled. Please make it active in the program settings.

8. When backing up a partition with the VSS (Volume Shadow Copy Service) mode, the program throws "VSS could
not be started for processed volume".

Most likely you try to back up a FAT32 partition, which is not supported by VSS. Please use the Paragon Hot
Processing mode instead.

9. | cannot back up my hard disk to an external hard drive. Once started, the operation is aborted with the
following error: Hard Disk management, Error Code 0x1100a. What is wrong here?

The problem is that the Microsoft VSS service is set as the default Hot Processing mode in the program. But this
service has not been started in your WindowsXP/Windows2003/Vista. Please start this service (right click on My
Computer > Manage > Services > find Microsoft Volume Shadow Copy Service and make it active. Set also to
start it automatically).

10. When running a backup operation with the Paragon Hot Processing mode enabled, | get an error: error code
0x1200e "Internal error during Hot Backup"

Most likely your hard disk contains bad blocks. Please fix the issue with your HDD manufacturer's tool.
You can find a name of the tool you need here: http://kb.paragon-software.com

11. When running a backup operation with the Microsoft VSS mode enabled, | get the following error: error code
0x12016 "VSS: can't read volume data”

Most likely your hard disk contains bad blocks. Please fix the issue with your HDD manufacturer's tool.
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You can find a name of the tool you need here: http://kb.paragon-software.com
12. When trying to back up to a network share, | get the following error: "i/o error" or "can't open/create file"
Please check whether you’ve got a permission to write to the selected destination or not.

13. When trying to restore a backup archive, | get the following error: "Can't restore to current selection" or
"Archive does not fit"

Most likely you're trying to restore a backup of the whole hard disk to a partition or vice versa.
14. | set up a timetable for a task, but it fails to execute.
There can be a number of reasons for that:

- Windows Task Scheduler does not work properly. Check whether it is so or not by scheduling a simple task (call
Notepad through scheduling);

- You don’t have permission to write to the selected backup destination.

Glossary

Active Partition is a partition from which an x86-based computer starts up. The active partition must be a primary
partition on a basic disk. If you use Windows exclusively, the active partition can be the same as the system volume.

In the DOS partitioning scheme, only primary partitions can be active due to limitations of the standard bootstrap.

The term backup originates from the time when the best way to protect valuable information was to store it in form of
archives on external media. It's become now a general notion to mean making duplications of data for protection
purposes.

Bootable Archive is created by adding a special bootable section when backing up the data to CD/DVDs. Thus you will
be able to restore the data from these archives without having to run the program, but by simply booting from these
CD/DVDs.

Cluster is the smallest amount of disk space that can be allocated to hold a file. All file systems used by Windows
organize hard disks based on clusters, which consist of one or more contiguous sectors. The smaller the cluster size, the
more efficiently a disk stores information. If no cluster size is specified during formatting, Windows picks defaults based
on the size of the volume. These defaults are selected to reduce the amount of space that is lost and the amount of
fragmentation on the volume. A cluster is also called an allocation unit.

Extended Partition is a partition type you create only on a basic MBR (Master Boot Record) disk. Extended partition is
used if you want to create more than four volumes on a disk, since it may contain multiple logical drives.

File System Metadata. The servicing structures of a file system, which contain information about allocating files and
directories, security information etc, are named the file system metadata. It is invisible for users and regular
applications because its accidental modification usually makes a partition unusable.

Hard Disk Geometry. Traditionally, the usable space of a hard disk is logically divided into cylinders, cylinders are
divided into tracks (or heads), and tracks are divided into sectors.

The triad of values {[Sectors-per-Track], [Tracks-per-Cylinder], [Amount-of-Cylinders]} is usually named the Hard Disk
Geometry or C/H/S geometry.

Tracks and cylinders are enumerated from "0", while sectors are enumerated from "1". These disk parameters play an
essential role in the DOS Partitioning scheme.
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Modern hardware uses an advanced scheme for the linear addressing of sectors, which assumes that all on-disk sectors
are continuously enumerated from “0”. To allow backward compatibility with older standards, modern hard disks can
additionally emulate the C/H/S geometry.

Hidden Partition. The concept of a "hidden" partition was introduced in the IBM OS/2 Boot Manager. By default, an
operating system does not mount a hidden partition, thus preventing access to its contents.

A method of hiding a partition consists in changing the partition ID value saved in the Partition Table. This is achieved by
XOR-ing the partition ID with a 0x10 hexadecimal value.

Master File Table (MFT) is a relational database that consists of rows of file records and columns of file attributes. It
contains at least one entry for every file on an NTFS volume, including the MFT itself. MFT is similar to a FAT table in a
FAT file system.

MBR & 1st track of the hard disk is the Oth sector of the disk. MBR (Master Boot Record) contains important
information about the disk layout:

- The used partitioning scheme;

- The starting records of the Partition Table;

- The standard bootstrap code (or the initial code of boot managers, disk overlay software or boot viruses).
Generally, the Oth sector is used for similar purposes in all existing partitioning schemes.

The MBR capacity is not sufficient to contain sophisticated boot programs. That’s why the on-boot software is allowed
to use the entire Oth track of the disk. For example, boot managing utilities such as LILO, GRUB and Paragon Boot
Manager are located in the Oth track.

Partition ID (or File system ID) is a file system identifier that is placed in the partition. It is used to quickly detect
partitions of supported types. A number of operating systems completely rely on it to distinguish supported partitions.

Partition ID is saved in appropriate entries of the Partition Table and takes only 1 byte of space.

Partition Label (or Volume Label) is a small textual field (up to 11 characters) that is located in the partition's boot
sector. This value is used for notification purposes only. It is detectable by any partitioning tool including the DOS FDISK
utility.

Modern operating systems save it within a file system, e.g. as a special hidden file. Thus it is able to contain a relatively
large amount of text in multiple languages.

Partitioning Scheme is a set of rules, constraints and format of the on-disk structures to keep information on partitions
located on a hard disk.

There are known several partitioning schemes. The most popular of them is the so-called DOS partitioning scheme. It
was introduced by IBM and Microsoft to use multiple partitions in the disk subsystems on IBM PC compatible
computers.

Another popular partitioning scheme is the so-called Logical Disks Model (LDM) that originates from the UNIX
mainframe systems. Veritas Executive accommodates a simplified version of LDM to the Windows 2000 operating
system.

Windows 2000 and XP support two quite different partitioning schemes: the old DOS partitioning scheme and the new
Dynamic Disk Management (DDM). The problem is that earlier versions of Windows do not support DDM. In addition,
most hard disk utilities do not support it as well.

Recovery Media is a CD/DVD disc, a USB flash card or even a floppy disk from which you can boot for maintenance or
recovery purposes.
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Root Directory is the top-level directory of a formatted logical drive to include other files and directories. In modern file
systems (Ext2/Ext3, NTFS and even FAT32) it does not differ from other directories. This is not the case for old FAT12
and FAT16 file systems.

Serial Number. In the DOS partitioning scheme, every hard disk and every partition has a 32-bit serial number
represented by an 8-figure hexadecimal value. It is stored in the MBR and its value is assigned when the MBR sector is
initialized by Microsoft standard disk managing tools, such as Windows Disk Administrator and the FDISK utility.

In fact, a hard disk's serial number is not important for most operating systems and software. It is known that Windows
NT, 2000 and XP store its value in the database of assigned drive letters.

A partition's serial number is stored in its boot sector (in FAT16, FAT32 and NFTS file systems). Its value is assigned when
the partition is formatted. It does not play an important role for most operating systems and software as well.
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